
AXIS 231D+/232D+ 

Network Dome Camera

User’s Manual



 2 
AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

About This Document
This manual is intended for administrators and users of the 
AXIS 231D+/232D+ Network Dome Camera, and is 
applicable for software release 4.40. It includes instructions 
for using and managing the AXIS 231D+/232D+ on your 
network. Previous experience of networking will be of use 
when installing and using this product. Some knowledge of 
UNIX or Linux-based systems would also be beneficial, for 
developing shell scripts and applications. Later versions of 
this document will be posted to the Axis Website, as 
required. See also the product’s online help, available via 
the Web-based interface.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit: 
http://www.openssl.org/

Legal Considerations
Camera surveillance can be prohibited by laws that vary 
from country to country. Check the laws in your local 
region before using this product for surveillance purposes. 
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation.
If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: Re-orient or relocate the receiving antenna. 
Increase the separation between the equipment and 
receiver. Connect the equipment to an outlet on a different 
circuit to the receiver. Consult your dealer or an 
experienced radio/TV technician for help. Shielded (STP) 
network cables must be used with this unit to ensure 
compliance with EMC standards.

USA - This equipment has been tested and found to 
comply with the limits for a Class A computing device 
pursuant to Subpart B of Part 15 of FCC rules, which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to 
cause interference, in which case the user at his/her own 
expense will be required to take whatever measures may be 
required to correct the interference. 

Canada - This Class A digital apparatus complies with 
Canadian ICES-003.

Europe  -  This digital equipment fulfills the 
requirements for radiated emission according to limit A of 
EN55022/1998, and the requirements for immunity 
according to EN55024/1998 residential, commercial, and 
light industry. Warning! This is a Class A product. In a 
domestic environment this product may cause radio 
interference, in which case the user may be required to take 
adequate measures.
Japan - This is a class A product based on the standard of the 
Voluntary Control Council for Interference from Information 
Technology Equipment (VCCI). If this is used near a radio or 
television receiver in a domestic environment, it may cause 
radio interference. Install and use the equipment according to 
the instruction manual.

Australia - This electronic device meets the requirements of 
the Radio communications (Electromagnetic Compatibility) 
Standard 1998 AS/NZS 3548. Warning! This is a Class A 
product. In a domestic environment this product may cause 
radio interference, in which case the user may be required to 
take adequate measures.

Liability
Every care has been taken in the preparation of this manual; 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right 
to make changes to the product and manuals without prior 
notice. Axis Communications AB makes no warranty of any 
kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties 
of merchantability and fitness for a particular purpose. Axis 
Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the 
furnishing, performance or use of this material.

Trademark Acknowledgments
Acrobat, Adobe, Boa, Ethernet, IBM, Internet Explorer, Linux, 
Macintosh, Microsoft, Mozilla, Netscape Navigator, UNIX, 
Windows, WWW are registered trademarks of the respective 
holders. Java and all Java-based trademarks and logos are 
trademarks or registered trademarks of Sun Microsystems, Inc. 
in the United States and other countries. UPnP is a certification 
mark of the UPnPTM Implementers Corporation. Axis 
Communications AB is independent of Sun Microsystems Inc.

RoHS
This product complies with both the European RoHS 
directive, 2002/95/EC, and the Chinese RoHS regulations, 
ACPEIP.

WEEE Directive
The European Union has enacted a Directive 2002/96/EC 
on Waste Electrical and Electronic Equipment (WEEE 
Directive). This directive is applicable in the European 
Union member states.

The WEEE marking on this product (see right) or its 
documentation indicates that the product must not be 
disposed of together with household waste. To prevent possible 
harm to human health and/or the environment, the product must 
be disposed of in an approved and environmentally safe recycling 
process. For further information on how to dispose of this product 
correctly, contact the product supplier, or the local authority 
responsible for waste disposal in your area. 

Business users should contact the product supplier for 
information on how to dispose of this product correctly. This 
product should not be mixed with other commercial waste.

Axis Customer Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. 

Search by product, category, or phrases
• report problems to Axis support staff by logging in to your 

private support area
• visit the Axis Support Web at www.axis.com/techsup/
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Safety Notice - Battery Replacement
The AXIS 231D+/232D+ uses a 3.0V CR2032 Lithium 
battery as the power supply for its internal real-time clock 
(RTC). This battery will, under normal conditions, last for 
a minimum of 5 years. Low battery power affects the 
operation of the RTC, causing it to reset at every 
power-up. A log message will appear when battery 
replacement is required.
The battery should not be replaced unless required!
If the battery does need replacing, please observe the 
following points:
Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, 
as recommended by the manufacturer.
• Dispose of used batteries according to the 
manufacturer's instructions.

AXIS 231D+/232D+ Network Dome Camera User’s 
Manual, Revision 2.1
Date: May 2007 
Part No: 28868r3
Copyright© Axis Communications AB, 2007
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 6 AXIS 231D+/232D+ - Description
AXIS 231D+/232D+
Ideal for demanding surveillance and remote monitoring applications, the AXIS 
231D+/232D+ Network Dome Camera features precise pan/tilt/zoom control, superior 
quality Motion JPEG and MPEG-4 video, advanced event management functionality, 4 
alarm inputs/4 alarm outputs (for e.g. door sensors, alarm bells), 50 preset positions, 
sequence modes and guard tours. With security features such as HTTPS and IP address 
filtering, the AXIS AXIS 231D+/232D+ is perfect for professional security installations.

Up to 20 viewers can access the camera simultaneously when using Motion JPEG and 
MPEG-4 unicast. Video can be viewed in 5 resolutions (up to 4CIF), image compression is 
configurable.

The AXIS 231D+/232D+ has a built-in Web server, providing full access to all features 
through the use of a standard web browser. The built-in scripting tool allows basic 
applications to be created, providing basic surveillance solutions. For advanced 
functionality, the Network Dome Camera can be integrated via the use of AXIS HTTP API. 
For more information, refer to http://www.axis.com/developer

Axis products are supported by the industry's largest base of application software for 
managing and recording video, and integrating alarm and access control systems. 

AXIS 232D+
The AXIS 232D+ Network Dome Camera is a day and night camera with an IR cut filter 
which enables the camera to capture color video in light conditions down to 0.3 lux, and 
black and white video in conditions down to 0.005 lux. The IR-cut filter can be 
automatically enabled/disabled according to the current light conditions or manually 
enabled/disabled from the internal web pages.
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Hardware Description

Serial number

Connection module
connector

Network connector

S/N

with Network and
 Power Indicators

Control button
Mounting slot for
fixing screw

Network Connector- After completion of the startup and self test routines, the Network 
and Power Indicators on the network connector flashes as follows:

Indicator Color Description

Detail - network connector:

Network
Indicator

Power
Indicator

Network Green Flashes for network activity

Power Green Normal operation

Amber Flashes green/amber during upgrade and when connecting to 
AXIS Internet Dynamic DNS Service

Control Button - Press this button to restore the factory default settings, as described in 
Resetting to Factory Default Settings, on page 48. The Serial Number (S/N) is located on 
the label on the unit.

Network Connector - The AXIS 231D+/232D+ connects to the network via a standard 
RJ45 connector. Supporting NWAY, the AXIS 231D+/232D+ detects the speed of the local 
network segment (10BaseT/100BaseTX Ethernet).

Connection Module - The connection module 
provides the physical interface to 4 transistor 
outputs, 4 digital inputs and is the connection 
point for AC power. See Connection Module, on 
page 50

AC Power

4 outputs
4 inputs

Connection module connector

.  
For instructions on how to install the AXIS 
231D+/232D+, please refer to the Installation 
Guide which is supplied with the product in 
printed format or in PDF format from the Axis 
Web site at http://www.axis.com
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Using the Network Dome Camera
This document includes instructions for using and managing the AXIS 231D+/232D+. 
Instructions on how to install the AXIS 231D+/232D+ on your network are provided in the 
AXIS 231D+/232D+ Installation guide which is available on the Axis Web site. The AXIS 
231D+/232D+ can be used with most standard operating systems and supports Microsoft 
Internet Explorer 6.x or later, Netscape 7.x or later and Mozilla 1.4 or later.

Accessing the AXIS 231D+/232D+

1. Start a Web browser (Internet Explorer, Mozilla, Netscape Navigator).

2. Enter the IP address or host name 
of the AXIS 231D+/232D+ in the 
Location/Address field of your 
Web browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your Web browser. 

Note: • To be able to view streaming video in Microsoft Internet Explorer, you must set your Web browser to allow 
ActiveX controls. If your working environment restricts the use of additional software components, you can 
configure the AXIS 231D+/232D+ to use a Java applet for updating images. Please refer to the online help 
files for more information.

• User functions in the AXIS 231D+/232D+ may have been customized to meet the specific requirements of 
the application. Consequently, many of the examples and functions in this section may differ from those 
displayed in your Live View page.
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If the AXIS 231D+/232D+ has been customized, the buttons and other items described 
below will be displayed accordingly on the Live View page. The following provides an 
overview of each button:

 
The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed.

The Output buttons control an output directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds. 
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view from 
preset positions at set intervals.

The Action buttons trigger an action directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in JPEG format 
on your computer.
  
Click the Ctrl panel button to access the following buttons:

• Auto focus: Automatically adjusts the image focus.
• Auto iris: Automatically adjusts the amount of light reaching 

the image sensor for best image results.
• Backlight comp: Enabling backlight compensation makes the 

subject clearer if the image background is too bright, or if the 
subject is too dark. 

• IR cut filter (AXIS 232D+ only) - when set to off, the camera 
will be able to “see” infrared light, e.g. at night, thus making 
the image clearer. The image is shown in black & white when 
the IR cut filter is off. Set to Auto to automatically turn the 
filter off when the available visible light falls below the mini-
mum requirement.

Note: There are different buttons in the Control Panel depending on the web browser you are using, but the 
descriptions and functionality are the same.
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Area Zoom
This allows you to draw a box over a desired area to zoom into. To activate, click the 
Center button described in the AMC viewer toolbar or in other Internet browsers choose 
PTZ > Center. Using your mouse click in the image and while holding down the left mouse 
button draw a square over the area you would like to zoom into.

Pan/Tilt/Zoom Controls
The Live View page also displays the Pan/Tilt/Zoom controls. The administrator 
can enable/disable the control for specified users under System Options > 
Security > Users > User List.

The AMC viewer toolbar (AXIS Media Control) is available from Microsoft Internet 
Explorer only and displays the following buttons:

The Play/Stop buttons start and stop the live video stream.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on the computer 
keyboard to cancel full screen view.
The record button is used to record the current video stream. The location where 
the image file is saved can be specified using the AMC control panel. To enable 
recording, Select Live View Config > Viewer Settings > Enable recording button.

Click the Set emulated joystick mode button and click in the image to move the 
camera in the desired direction
Click the Center button and the camera view will center on the position that was 
clicked. The location to move to has a definite position, e.g. 'position x,y.
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Pan/Tilt/Zoom Control Queue
The time the user is in control of the PTZ settings is limited and a queue of users has been 
set up. Use the buttons to request or release control of the Pan/Tilt/Zoom controllers. 

The Pan/Tilt/Zoom Control Queue is set up by the administrator under:  
Dome Configuration > Advanced > PTZ Control Queue. For more information on using 
Pan/Tilt/Zoom controls, please see page 25.

AXIS 295 Video Surveillance Joystick
The AXIS 295 is a USB device that gives responsive and accurate control of the pan, tilt, 
zoom functionality. On installation, the joystick is automatically detected by AXIS Media 
Control where the 12 buttons can be programmed for a customized video surveillance 
system. For more information, please visit the Axis Website at http://www.axis.com
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Video Streams
The AXIS 231D+/232D+ provides several different image and video stream formats. The 
type to use depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 231D+/232D+ provides access to Motion JPEG and 
MPEG-4 video streams, as well as to single JPEG images. Other applications and clients 
can also access these video streams/images directly, without going via the Live View page. 

Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses considerable amounts of bandwidth, but also provides 
excellent image quality and access to each and every individual image contained in the 
stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high quality video streams at less than 1 Mbit/s. 

Notes: • MPEG-4 is licensed technology. The AXIS 231D+/232D+ includes one viewing client license. Installing 
additional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact 
your Axis reseller.

• All clients viewing the MPEG-4 stream must use the same image settings.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 231D+/232D+ provides certain 
subsets of these tools. These are represented as Video object types, which are selected for 
use with different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS 

Media Control) 

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable 
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.
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How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first 
consideration for live video, especially when it is important to always have an up-to-date 
video stream, even if some images do get dropped. This can be configured as multicast or 
unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting. However, if more and more 
unicast clients connect simultaneously, the server will at some point become overloaded. 
There is also a maximum of 20 simultaneous viewers to be considered.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.
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The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the 
AXIS 231D+/232D+ is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer 
in Windows. This ActiveX component is automatically installed on first use, after which it 
can be configured by opening the AMC Control Panel applet from the Windows Control 
Panel. Alternatively, right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 231D+/232D+ can also be accessed in the following ways:

• If supported by the client, the AXIS 231D+/232D+ can use Motion JPEG server push to 
display video. This option maintains an open HTTP connection to the browser and sends 
data as and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The 
paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/media.amp

Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. For some other clients, e.g. QuickTime™ the Video Object Type must be 
set to Simple. It may also be necessary to adjust the advanced MPEG-4 settings.To assess 
the video stream from e.g. QuickTime™ the following path can be used:

rtsp://<ip>/mpeg4/1/media.amp 

This path is for all supported methods, and the client will negotiate with the network 
camera to determine exactly which transport protocol to use.

Notes: <ip> = IP address
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Configuring the Network Dome Camera
This section describes how to configure the AXIS 231D+/232D+ and is intended for the 
product administrator who has unrestricted access to all Setup tools and Operator who 
has access to Video & Image, Live View Config and Event Configuration. See the section 
on Security, on page 36 for more information on user access control.

The AXIS 231D+/232D+ is configured under Setup from a standard browser.

Accessing the Setup Tools

Follow the instructions below to access the Setup Tools from a Web browser.

1. Start the Web browser and enter 
the IP address or domain name 
of the AXIS 231D+/232D+ in 
the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup configuration 
tools.

Overview of the Setup Tools

Setup Configuration
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Video & Image Settings

The following descriptions offer examples of the available features in the AXIS 
231D+/232D+. For details of each setting, please refer to the online help files which are 
available from each page. Click  to access the help files.

Image Settings
To optimize the video images according to your requirements, modify the following 
settings under Image Appearance. Each setting is described in the online help files 

All configuration of images and overlays will affect the performance of the network 
camera, depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
• Rotating the image 90 or 270 degrees will lower the maximum frame rate
See also the specifications for frame rates and bandwidth in General performance 
considerations, on page 59. 
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Overlay Settings
Use these settings to include an image 
as an overlay, and/or the date and 
time, along with text of your own. 

Text overlays are all included on one 
line at the top or bottom of the video 
image. Image overlays can be placed 
anywhere in the video image. 

To upload an overlay image, see 
below.

Example: If there is information in a monitored 
area that you do not wish to disclose, 
you can mask it out by placing an 
overlay image on top. Setting the 
overlay image anywhere in the video 
image using coordinates allows preci-
sion detail masking.

Video Stream
The Maximum video stream time can be set as Unlimited, or a maximum stream time per 
session in seconds, minutes or hours can be defined. When the set time has expired, a new 
stream can be started by refreshing the page in the Web browser. Note that the maximum 
video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Please use the online help files for more information.

Date &
Time

Overlay
image
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Overlay Image Settings

An overlay image is an image included in the video image. This might, for example, be 
your own company logo. Follow these instructions to upload and use an overlay image:

Overlay image requirements Overlay image limitations
Image Formats Image Size

The height and width of the overlay 
image in pixels must be exactly 
divisible by 4.

1. Go to Setup > Video & Image > Overlay Image. 

2. To upload the file (a logo or image) to the AXIS 231D+/232D+, click the Browse 
button and locate it on your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

4. The image is now available in the Use overlay image drop-down list.

5. Click Save.

6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Advanced Camera Settings

To optimize the lighting settings according to your requirements, modify the following 
settings under Lighting Conditions:

• White balance - the white balancing system in the AXIS 231D+/232D+ can 
automatically detect white in the image and intelligently use this as a reference 
for other colors.

• Exposure control - this setting is used to adapt to the amount/type of light being 
used.

• IR cut filter (AXIS 232D+ only)- when the IR cut filter is set to OFF, the camera 
will be able to ‘see’ infrared light, e.g. at night, thus making the image clearer. 
The image is shown in black & white when the IR cut filter is off. 
 

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

• If the image overlay and text overlay are larger 
than the video image, no overlay will be dis-
played. When also using a text overlay, this 
will occupy 16 pixels in height and as many in 
width as the video image.

• If the overlay is initially positioned so that 
part of it is outside the video image, it will be 
relocated so that it appears over the video 
image, i.e. the entire image is always dis-
played.

• The maximum overlay image size supported by 
the AXIS 231D+/232D+ is the same as the 
maximum image resolution. See Technical 
Specifications, on page 46.
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Note that if the AXIS 232D+ is set to Auto, it will automatically switch between 
IR cut filter ON and OFF, according to the current lighting conditions. This is only 
possible when the iris is set to Auto Iris, and the exposure control is set to 
Automatic.

• Backlight compensation - this setting is used to make the subject appear clearer, 
e.g. against a bright background.

Image Settings
• Auto focus enabled (default setting).
• Sensitivity - sets the speed of the auto focus. High is used when focusing on 

objects that move frequently. Low improves the stability of the focus.

Note: In certain situations, the white balancing system will not operate effectively. Problems may occur if the 
image contains no white color at all, or if the dominant color is not white. In these circumstances, the 
white balance may incorrectly be based on another visible color in the image, and colors may become dis-
torted. A pale background picture with reddish or blue foreground objects is very symptomatic of this con-
dition. In such cases it is recommended that a fixed white balance setting is selected. 

Please use the online help files for more information.

MPEG-4 Settings

Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help files
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Live View Config

Layout

These are the tools for deciding the layout 
of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is 
unchanged.

• Use custom settings - modify the 
default page with your own colors, 
images etc. Click the Configure button 
and see the following page.

• Own Home Page - Upload and use your 
own custom made page as the default 
web page. Click the Configure button 
and see the following page.

The other settings on this page concern 
which other features to include, e.g. 
buttons and links. See page 22 for more 
information.

Customizing the default page
The appearance of the default AXIS 
231D+/232D+ Live View page can be 
customized to suit your own 
requirements, or you can upload and 
use your own home page. To upload 
your own files, click the 
Upload/Remove button and see the 
description below.

Upload Own Web Files
Your own web files, background 
picture, color etc. must first be 
uploaded to the AXIS 231D+/232D+ 
in order to be available for selection 
in the Custom Settings setup dialog. 
Once uploaded, the files are shown in 
the drop-down list.

Note that the setup address is:

 http://<ip address>/operator/basic.shtml
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1.Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2.Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3.When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

• To use your uploaded file, click the radio button and select the file from the drop-down 
list by Own:

• To use an external file located somewhere other than in the AXIS 231D+/232D+, click 
the radio button and enter the URL by External:

Own Home Page
To use a previously uploaded web page as the default page, check the checkbox, select the 
page from the drop-down list and click OK.

User Defined Links 
User defined links can be CGI links or web links. 
Once configured, the link(s) will appear on the Live 
View page.

To set up a web link, select the Use as web link 
radio button, enter a descriptive name and enter the 
URL in the provided field. Click Save and the link 
will appear on the Live View page. 

User defined CGI links can be used to issue HTTP 
API requests, e.g. PTZ commands. 

Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM START.

3. Select the Use as cgi link radio button and enter 
the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM STOP.

6. Select the Use as cgi link radio button and enter the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the AXIS 
231D+/232D+.

User Defined Links
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For more information on the Axis HTTP API, see the Support / Developer pages on the Axis 
Web site at http://www.axis.com.

Please use the online help files for more information.

For more information on the Axis HTTP API, see the Support / Developer pages on the Axis 
Web site at http://www.axis.com. See also the section on PTZ, on page 25.

Action Buttons
These buttons can be used to manually trigger and stop an event from the Live View page. 
The snapshot button allows you to take a snapshot of the video stream and save it to a 
computer.

Output Buttons
These buttons are used to control the outputs on the AXIS 231D+/232D+ and thus the 
equipment connected to them, e.g. to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format

Select the default video format to use on the Live View page. Checking the box for Show 
video format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

When using MPEG-4 as the video format, the default viewer is AXIS Media Control with 
Internet Explorer.

Note: It is also possible to view Motion JPEG when MPEG-4 is chosen as default and vice versa.

Default Viewer
From the drop-down lists, select the default method for viewing video images for your 
browser. The camera will attempt to show the video images in the selected video format 
and viewer. If this is not possible, the camera will override the settings and select the best 
available combination.

AMC Recommended viewer in Windows Internet Explorer (MPEG-4 /Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to AMC. Requires one of the following installed on the client:

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Server Push Recommended viewer for other browsers (Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to Server Push (Motion JPEG only).

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Browser Viewer Description

Windows 
Internet Explorer • JVM (J2SE) 1.4.2 or higher

• JRE (J2SE) 5.0 or higher

Other browsers
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Viewer Settings

Checking the Show viewer toolbar box displays the AMC toolbar under the video stream. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Check the Show crosshair in PTZ joystick mode checkbox to indicate the center of the 
image when viewing the video stream in PTZ joystick mode.

Check Use PTZ joystick mode as default to set PTZ mode to joystick.

Check Enable recording button to start an MPEG-4 recording directly from the Live View 
page.

HTML Examples

You can add live video from your AXIS 231D+/232D+ to your own web site. The video 
server can send Motion-JPEG or MPEG-4 images to up to 20 simultaneous connections, 
although an administrator can restrict this to fewer. This does not affect or include the 
number of multicast viewers.

Enter the Image Type, Image size and other settings to suit your web page and click 
Update.

External Video

An external video source is a source originating from some other Axis device on the 
network. The images from these sources can be displayed just as if they were produced by 
the AXIS 231D+/232D+.

The External Video Source list shows all of the external video sources currently 
configured. The information displayed is the source's name and the path to the video 
stream. Up to 20 external video sources can be configured.

Working with External Video Sources
1. To add a new video source, click the Add button. This opens the External Video 

Source Setup dialog, which is used to make all the necessary settings.

2. To modify an existing video source, select it and click the Modify button.

3. To delete an external video source, select it and click the Remove button.
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Sequence Mode

Sequence Mode is a configuration that automatically displays the view from multiple, 
previously defined Preset Positions (see Dome Configuration, on page 28 and the online 
help).

This is useful for e.g. security personnel viewing a surveillance system that constantly 
rotates through the selected preset positions, in the listed order, or randomly. 

To set up sequence mode, simply select the desired preset positions and enter the number 
of seconds or minutes to display each position for. Each position can be displayed for up to 
59 minutes.

Note: The Sequence mode is only active as long the browser is open.

Pan Tilt Zoom Controls

The controls available for Pan Tilt Zoom (PTZ) are displayed on the Live View page by 
default. The administrator can enable/disable the controls for specified users.

Source / 
Preset positions

Tilt bar
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PTZ controls
• the Pan bar - moves the camera to the right and left 
• the Tilt bar - tips the camera up and down
• the Zoom bar - zooms the view in and out
• the Focus bar - adjusts the focus
• the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the 
camera to a new position.

Each position on the bar (see right) represents a 
defined position in the camera’s range of movement, 
with the center of the bar representing the point midway between the two extremes of 
movement.

Clicking a position directly on the bar moves the camera directly to the new position in 
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped, 
incremental change. 

Click-in-image
The PTZ device can also be controlled using click-in-image movement, which can also be 
of relative or absolute type.

Absolute click-in-image movement means that the camera view will center on the absolute 
position that was clicked.

Relative click-in-image movement means that by clicking and holding the mouse button 
down in the image, the PTZ device moves the camera in that direction, relative to the 
center of the image. The further from the center the image is clicked, the greater the 
movement.

You can also use Area Zoom to draw a box over a desired area to zoom in on. Using your 
mouse click in the image where you want the center of the area you are are going to zoom 
in on, and while holding down the left mouse button draw a square over the size of area 
you would like to zoom in on.

Focus and Iris Controls
The Focus and Iris (image brightness) can be adjusted manually by using the control bars, 
or they can be set for automatic adjustment, by clicking the Auto Iris and Auto Focus 
buttons.
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Preset Positions
These presets are selected from the drop-down Source list on the Live View page and will 
move and/or zoom the camera to a pre-defined position, i.e. to cover an area of particular 
interest. Events can also be configured to go to preset positions when triggered. For 
information on setting up preset positions, please see Dome Configuration, on page 28 and 
the online help.

PTZ Control Queue 
This indicates that PTZ queueing has been enabled. This means that the time the user is in 
control of the PTZ device is limited and that a user queue has been set up. Use the buttons 
to request or release control of the PTZ controls. For information on how to set up the 
control queue, please see PTZ Control Queue on page 29 and the online help.

Using CGI links to control PTZ devices
User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g. 
PTZ commands. These links are configured in the Live View Layout settings, see page 22.
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Dome Configuration

Preset Positions

A preset position is a pre-defined camera view than can be used to quickly move the 
camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera 
to the required position. When satisfied with the camera's position, enter a descriptive 
name. The camera position, iris and focus settings are then saved as a preset position. 

The position can be assumed at any 
time, by selecting the preset's name 
from the Preset positions drop-down 
list. Preset positions can be selected in 
Live View, from events, in Sequence 
mode and in the Guard Tour.

One position can be set as the Home 
position, which is readily accessible by 
clicking on the Home button in both the 
Preset Position Setup window. The 
position's name will have Home (H) 
added, e.g. Office Entrance Home (H).

Guard Tour

A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined 
order or randomly, and for configurable time periods. Unlike the Sequence Mode, which is 
a viewing application under Live View Config (see Live View Config, on page 21), the 
guard tour sequence will keep running after the user has logged off or closed the browser.

Once the preset position has been set, and added to the guard tour, the following settings 
can be made:

• Set a pause between runs
• Add and remove postions
• View Time in seconds or minutes 
• Move Speed - sets the speed of the Pan/Tilt movements to the preset position
• View Order (or Random)
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Advanced

Limits
Define the pan, tilt, zoom and focus limits for the AXIS 231D+/232D+. Movements to the 
left and right, up and down can be restricted to narrow the area under surveillance. The 
near focus limit can be set to avoid focusing on objects too close to the camera.

Notes: Once a limit has been saved, this position can not be exceeded by the AXIS 231D+/232D+ unless the val-
ues have been reset and saved to a greater value first (i.e. reset the default values of the mechanical restric-
tions).

Continuous zoom or focus movements may not always honour the limits.

Move speed sets the speed of the camera's Pan/Tilt movements. The default setting is 
maximum speed.

Ctrl Panel
Use the Ctrl Panel to configure shortcut command buttons.

Calibration
The calibration page gives instructions for calibration of the AXIS 231D+/232D+.

Control Queue

The administrator can set up a queue for the PTZ controllers. Once set up, the PTZ Control 
Queue buttons will appear on the Live View page offering one viewer exclusive control for 
a limited amount of time. Other users will be placed in the queue. For an overview of Pan 
Tilt Zoom controls, see page 25.

PTZ Control Queue on Live View page

Please use the online help files for more information.
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Event Configuration
This section describes how to configure the AXIS 231D+/232D+ for event handling. The 
AXIS 231D+/232D+ can be configured to perform certain actions when certain types of 
events occur.

Event Servers

Event Servers are used, e.g. for receiving uploaded image files and/or notification 
messages. To set up Event server connections in your AXIS 231D+/232D+, go to Setup > 
Event Configuration > Event Servers and enter the required information according to the 
selected server type.

Server type Purpose Requires information

HTTP Server

TCP Server

For details on each setting, please refer to the online help files  which are available 
from each web page.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test will take approximately 10 seconds). 

FTP Server
• used for uploading saved images • IP/Hostname

• Descriptive name of your choice
• User Name and Password (to FTP server)

• used for notification messages
• used for uploading saved images

• Descriptive name of your choice
• URL
• User Name and Password (to HTTP server)

• used for notification messages • IP/Hostname
• Descriptive name of your choice
• Port number e.g. port 80
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Event Types
An Event Type is a set of parameters 
describing how and when the 
Network Dome Camera is to perform 
certain actions.

Example: If a door is opened, and an event 
has been configured to act on this, the Network 
Dome Camera can e.g. record and save video 
images to an FTP server or send a notification 
email to a pre-configured email address with a 
pre-configured message. Video images can be 
sent as an attachment with the email.

Triggered Event
A Triggered event is activated from, e.g:

• a switch (doorbell) connected to an input port on the Network Dome Camera
• PTZ preset position
• built-in motion detection
• a manually activated action e.g. from a manual trigger button in the web 

interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the Network Dome Camera to upload images when the 
main door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. an Input 
port with a connected sensor if the door is opened.

6. Set the When Triggered... parameters i.e. set what the Network Dome Camera is to 
do if the main door is opened e.g. upload images to an FTP server.

7. Click OK to save the Event in the Event Types list.

 

Please use the online help files for descriptions of each available option.
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Pre-trigger and Post-trigger buffers
This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 10 seonds before and after a door has been opened. 

Go to Event Types > Add Triggered... > 
When Triggered... and check the Upload 
images checkbox to expand the web page 
with the available options.

Buffer size - up to 9 MB buffer. The 
maximum length of time of the 
pre-/post-buffer depends on the image 
size and selected frame rate.

Include pre-trigger buffer - images 
stored internally in the server from the 
time immediately preceding the trigger. 
Check the box to enable the pre-trigger 
buffer, enter the desired length of time 
and specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger.

Notes: If the pre- or post-buffer is too large for the internal memory, the frame rate will be reduced and individ-
ual images may be missing. If this occurs, an entry will be created in the unit's log file.

Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum available) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.
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Scheduled Event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event
This example describes how to set the Network Dome Camera to send an email notification 
with saved images from at a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the 
event, e.g. Scheduled email.

3. Set the priority (High, Normal or 
Low).

4. Set the Activation Time parameters 
(24h clock) when the event is to be 
active, e.g. start on Fridays at 18.00 
with a duration of 62 hours.

5. Set the When Activated... parameters 
i.e. set what the Network Dome 
Camera is to do at the specified time 
e.g. send uploaded images to an 
email address.

6. Click OK to save the Event in the Event Types list.

Please use the online help files for descriptions of each available option.
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Motion detection
In the Motion Detection menu, you can configure the video source(s) for motion detection. 
The motion detection feature is used to generate an alarm whenever movement occurs (or 
stops) in the image. The AXIS 231D+/232D+ can use a maximum of 10 Include/Exclude 
windows.

• Include windows target specific areas within the image
• Exclude windows are areas to be ignored within the Include window

Once configured, the motion detection windows will appear in a list when motion 
detection is selected to trigger an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the video server.

How to configure Motion Detection
This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Windows radio button.

3. Click New.

4. Enter a descriptive name of your choice under Windows name.

5. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).
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6. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

7. Click Save.

Please use the online help for descriptions of each available option.

High Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects against ordinary 
backgrounds will trigger the motion 
detection

Low Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects against a dark 
background will trigger motion detection

Default values Low Medium to High Medium to High

Examples: 

• Avoid triggering on small objects in the image by selecting a high size level.
• To trigger motion detection as long as there is activity in the area, select a high history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status

Under Event Configuration > Port Status there is a list that shows the status for the 
connected inputs and outputs of the AXIS 231D+/232D+ for the benefit of the Operator 
who cannot access the System Options section.

Example: If the Normal state for a push button (e.g. doorbell) connected to an input is set to Open circuit - as 
long as the button is not pushed, the state is inactive. If the push button is pushed, the state of the input 
changes to active.

If there are parts of the Include window that you wish to exclude, click the 
Configure Excluded Windows radio button and perform steps 1-6 above. 
Click Save.

Parameter Object Size History Sensitivity



 36 AXIS 231D+/232D+ - System Options
System Options

Security

User access control is enabled by default, the administrator sets the root password on first 
access. Other users are authorized with user names and passwords, or the administrator can 
choose to allow anonymous viewer login to the Live View page, as described below:

Users 
The user list displays the authorized users and access levels:

User Description

Viewer Provides the lowest level of access, which only allows the user access to the Live View page.

Operator An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.

Administrator An administrator has unrestricted access to the Setup Tools and can determine the registration of all 
other users. 

User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Anonymous PTZ control login - allows any viewer access to the Pan/Tilt/Zoom 
controllers on the Live View page.

IP Address Filtering 
Enable IP Address Filtering- To allow or deny access to the AXIS 231D+/232D+ Network 
Camera check the box Enable IP address filtering. Once enabled, the IP addresses in the 
list will be allowed or denied access according to the choice made in the drop-down list 
Allow/Deny the following IP addresses. 

The administrator can add up to 256 IP address entries to the list (a single entry can 
contain multiple IP addresses). The users from these IP addresses need to be specified in the 
user list with the appropriate access rights. This is done from Setup > System Options > 
Security > Users. 

Referrals 
To prevent unauthorized sources from including the video stream from the AXIS 
231D+/232D+ into external Web pages, check the Referrals checkbox and enter the IP 
address or Host name of the computer that hosts the Web pages with the included video 
stream. Several IP addresses/host names can be defined and are separated by semicolons(;)
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Notes: • If the referrals feature is enabled and you wish to also allow normal access to the Live View page, the 
product's own IP address or host name must be added to the list of allowed referrers.

• Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP address 
filtering must be enabled.

• Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, 
then the allowed referrers are automatically restricted to those allowed IP addresses.

HTTPS
For greater security, the AXIS 231D+/232D+ can be configured to use HTTPS (Hypertext 
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would 
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 231D+/232D+, a Certificate 
must be created using one of the following methods:

• A self-signed certificate can be created in the network camera, but this does not guar-
antee the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages 
security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields.

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy and 
send to a CA for signing. When the signed certificate is returned, click Install signed 
certificate... to install the certificate in the AXIS 231D+/232D+.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please refer to the online help files

802.1X - Network Admission Control
IEEE 802.1X is an IEEE standard for port-based Network Admission Control. It provides 
authentication to devices attached to a network port (wired or wireless), establishing a 
point-to-point connection, or, if authentication fails, preventing access on that port. 
802.1X is based on EAP (Extensible Authentication Protocol). 

In a 802.1X enabled network switch, clients equipped with the correct software can be 
authenticated and allowed or denied network access at the Ethernet level. 
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Clients and servers in an 802.1X network may need to authenticate each other by some 
means. In the Axis implementation this is done with the help of digital certificates 
provided by a Certification Authority. These are then validated by a third-party entity, 
such as a RADIUS server, examples of which are Free Radius and Microsoft Internet 
Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of 
which there are many. The one used in the Axis implementation is EAP-TLS 
(EAP-Transport Layer Security). 

The AXIS network video device presents its certificate to the network switch, which in turn 
forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate 
and responds to the switch, and sends its own certificate to the client for validation. The 
switch then allows or denies network access accordingly, on a preconfigured port. 
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The authentication process

RADIUS
RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication, 
Authorization and Accounting) protocol for applications such as network access or IP 
mobility. It is intended to work in both local and roaming situations.

CA servers
In cryptography, a Certification Authority (CA) is an entity that provides signed digital 
certificates for use by other parties, and thus acts a trusted third party. 

There are many commercial CA’s that charge for their services. Institutions and 
governments may have their own CA, and there are free CA’s available. 

Protected network

Axis video device

Q: Certificate OK?

Certificate 
Authority (CA)

3

1

2

4

A: OK

RADIUS
server

Network
switch

Q: Certificate OK?
A: OK

Certificate

Certificate

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network switch. 
The switch forwards the video device’s CA certificate to the RADIUS server, which then 
replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which 
also replies to the switch. 

4. The switch keeps track of all responses to the validation requests. If all certificates are 
validated, the Axis video device is allowed access to the protected network via a 
preconfigured port.
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Date & Time

Current Server Time  - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay Images (see below).

New Server Time  - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 

From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your computer. 
• Synchronize with NTP Server - the network camera will obtain the time from an NTP 

server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.

Date & Time Format Used in Images  - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the help files for information on how to create 
your own file formats.
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Network - Basic TCP/IP Settings

IP Address Configuration
Your Axis network camera supports both IP version 4 and IP version 6. Both versions may 
be enabled simultaneously, and at least one version must always be enabled. 

When using IPv4, the IP address can be set automatically via DHCP, or a static IP address 
can be set manually. 

If IPv6 is enabled, your camera will receive an IP address according to the configuration in 
the network router.

There are also options for setting up notification of changes in the IP address, and for 
using the AXIS Internet Dynamic DNS Service. For more information on setting the IP 
address, please see the online help.

Notes: 

• DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may 
lead to the situation where the IP address changes and you lose contact with the camera. Configure the 
options for notification of IP address change (under Services) to receive notification from the camera when 
the IP address changes.

• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 231D+/232D+ by host 
name which is always the same, regardless of the IP address.

 

Services
Enable ARP/Ping setting of IP Address - The IP address for the AXIS 231D+/232D+ can 
be set using the ARP/Ping method, which associates the unit's MAC address with an IP 
address. 

Options for notification of IP address change - If the IP address for the video server 
changes, e.g. automatically by DHCP, you can choose to be notified of the change. Click 
Settings... and enter the required information.

AXIS Internet Dynamic DNS Service - The AXIS Internet Dynamic DNS Service can 
provide your Axis product with its own URL (web address), which can then be used to 
access it over the Internet. The product can be unregistered from the service at any time. To 
do this click Settings... and follow the instructions. For more information, please refer to 
the online help.
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Network - Advanced TCP/IP Settings

DNS Configuration
DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 
231D+/232D+. Multiple domains can be separated by semicolons (;). The host name is 
always the first part of a Fully Qualified Domain Name, e.g. myserver is the host name in 
the Fully Qualified Domain Name myserver.mycompany.com where mycompany.com is 
the Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP Configuration
The AXIS 231D+/232D+ can obtain the correct time from an NTP server. The address for 
the NTP server can either be obtained via the DHCP server, or it can be entered manually. 

Host Name Configuration
The AXIS 231D+/232D+ can be accessed using a host name, instead of an IP address. The 
host name is usually the same as the assigned DNS Name. It is always the first part of a 
Fully Qualified Domain Name and is always one word, with no period. For example, 
myserver is the host name in the Fully Qualified Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host 
name, allowing your computer to be more easily accessed from various locations on the 
Internet. Outside users can always access your server using the associated DNS name 
regardless of the WAN IP. The DNS server used by the user and/or the DNS server 
responsible for the domain in use must support RFC2136 and allow updates from the AXIS 
231D+/232D+.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS 
server should be remembered when checking that the domain name for the registered IP 
address is still valid. For more information, please see the online help

Link-Local Address
This is enabled by default and assigns the AXIS 231D+/232D+ an additional IP address for 
use with UPnP™. The AXIS 231D+/232D+ can have both a Link-Local IP and a 
static/DHCP-supplied IP address at the same time - these will not affect each other. 
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HTTP 
The default HTTP port number (80) can be changed to any port within the range 
1024-65535. This is useful for e.g. simple port mapping.

HTTPS
The default HTTPS port number (443) can be changed to any port within the range 
1024-65535. HTTPS is used to provide encrypted web browsing.

NAT Traversal
A broadband router allows devices on a private network (LAN) to share a single connection 
to the Internet. This is done by forwarding network traffic from the private network to the 
“outside” i.e. the Internet. Security on the private network (LAN) is increased since most 
broadband routers are pre-configured to stop any attempts to access the private network 
(LAN) from the public network/Internet.

Use NAT traversal when your AXIS 231D+/232D+ is located on an intranet (LAN) and you 
wish to make it available from the other (WAN) side of a NAT router. With NAT traversal 
properly configured, all HTTP traffic to an external HTTP port in the NAT router will be 
forwarded to the camera.

LAN (intranet) WAN (internet)

Broadband 
(NAT)
router

ISP

Notes: • For NAT traversal to work, this must also be supported by the broadband router.
• The broadband router has many different names: “NAT router”, “Network router“, Internet Gateway”, 

“Broadband sharing device” or “Home firewall” but the essential purpose of the device is the same.

Enable/Disable - When enabled, the AXIS 231D+/232D+ will attempt to configure port 
mapping in a NAT router on your network, using UPnP™. Note that UPnP™ must be 
enabled in the camera (see System Options > Network > UPnP).

Use manually selected NAT router - Select this option to manually select a NAT router 
and enter the IP address for the router in the field provided.

If a router is not manually specified, the AXIS 231D+/232D+ will automatically search for 
NAT routers on your network. If more than one router is found, the default router will be 
selected.
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Alternative HTTP port - Select this option to manually define an external HTTP port. Enter 
the port number in the field provided. If no port is entered here a port number will 
automatically be selected when NAT traversal is enabled. 

Notes: • An alternative HTTP port can be used/be active even if NAT traversal is disabled. This is useful if e.g. your 
NAT router does not support UPnP and you need to manually configure port forwarding in the NAT router.

• If you attempt to manually enter a port that is already in use, another available port will automatically be 
selected.

• When the port is selected automatically it will be displayed in this field. This can be changed by entering a 
new port number and clicking Save.

RTSP
The RTSP protocol allows a connecting client to start an MPEG-4 stream. Enter the RTSP 
port number to use. The default setting is 554.

FTP
The FTP server running in the AXIS 231D+/232D+ enables the upload of e.g. new 
firmware, user applications, etc. Check the box to enable the service. 

Network Traffic 
The default setting is Auto-negotiate which means that the correct speed is automatically 
selected. If necessary, you can set the connection speed by selecting it from the drop-down 
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the 
network camera is allowed to use on your network. This is a useful function when 
connecting your network camera to busy or heavily loaded networks. The default setting is 
Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may 
create problems for individual video streams if the maximum value is less than the sum of the bit rates set 
for the video streams. 

For more information, please see the online help

SOCKS 

SOCKS is a networking proxy protocol. The AXIS 231D+/232D+ can be configured to use a 
SOCKS server to reach networks on the other side of a firewall/proxy server. This 
functionality is useful if the AXIS 231D+/232D+ is located on a local network behind a 
firewall, but notifications, uploads, alarms, etc., need to be sent to a destination outside the 
local network (e.g. to the Internet).
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Network - QoS (Quality of service)
Quality of Service (QoS) provides the means to guarantee a certain level of a specified 
resource to selected traffic on a network. Quality can be defined as e.g. a maintained level 
of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware 
network can be summarized as:

• The ability to prioritize traffic and thus allow critical flows to be served before 
flows with lesser priority.

• Greater reliability in the network, thanks to the control of the amount of band-
width an application may use, and thus control over bandwidth races between 
applications.

The QoS in Axis network video products marks the data packets for various types of 
network traffic originating from the product. This makes it possible for network routers 
and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The 
following types of traffic are marked:

• live video
• live audio
• event/alarm traffic
• management network traffic.

QoS Settings  
For each type of network traffic supported by your Axis network video product, enter a 
DSCP (Differentiated Services Codepoint) value. This value is  used to mark the traffic’s IP 
header. When the marked traffic reaches a network router or switch, the DSCP value in the 
IP header tells the router or switch which type of treatment to apply to this  type of traffic, 
for example, how much bandwidth to reserve for it.  

Note that DSCP values can be entered in decimal or hex form, but saved values are always 
shown in decimal.

For more infomation on Quality of Service, please see the Axis support web at 
www.axis.com/techsup

SMTP (email)

(Simple Mail Transfer Protocol) Enter the host names or addresses for your primary and 
secondary mail servers in the fields provided to enable event and error email messages 
from the AXIS 231D+/232D+ to predefined addresses, via SMTP.
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Network - SNMP
The Simple Network Management Protocol (SNMP) allows remote management of network 
devices. Depending on the level of security required, select the version of SNMP to use. The 
three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a pass-

word for read or read/write access to all supported SNMP objects. The community is the 
the group of network devices using SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.

UPnP™

(Universal Plug and Play) The AXIS 231D+/232D+ includes support for UPnP™ in Windows 
ME and Windows XP. UPnP™ is enabled by default.

Note: UPnP must be installed on your workstation. To do this, open the Control Panel from the Start Menu and 
select Add/Remove Programs. Select Add/Remove Windows Components and open the Networking Ser-
vices section. Click Details and then select UPnP as the service to add. Refer to the Windows help files for 
more information.

RTP (Multicast)/ MPEG-4
These settings are for the IP addresses, port numbers, and Time-To-Live values to use for 
media streams in the MPEG-4 format. 

Port Range - The RTP Port range defines the range of ports from which the video/audio 
ports are automatically selected. This feature is useful if the AXIS 231D+/232D+ is 
connected to a NAT router with manually configured port mapping.

Multicast - Only IP addresses within certain ranges can be used for multicasting. The 
AXIS 231D+/232D+ has been pre-configured with addresses from these ranges, and does 
not normally need to be reconfigured.

For more information, please see the online help.

Network - Bonjour
Your Axis network camera includes support for Bonjour. When enabled, the camera is 
automatically detected by operating systems and clients that support this protocol. 

Ports & devices - I/O Ports

The pinout, interface support and the control and monitoring functions are described in 
the section on the Connection Module, on page 50.
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Maintenance

• Restart - The unit is restarted without changing any of the settings. Use this method if 
the unit is not behaving as expected.

• Restore - The unit is restarted and most current settings are reset to factory default val-
ues. The settings that will not be reset are as follows:

• the boot protocol (DHCP or static)
• the static IP address
• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the network camera's settings to the factory default values (including the IP address).

Dome Status - Click the Test button to check the camera and dome mechanics for errors. 
Contact Axis Customer Services if you receive an error message as the result of this test.

Upgrade Server - See Support, on page 47.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it is then possible to return to a previous configuration if settings are 
changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for multi-configurations or for firmware upgrades.

Support

Support Overview
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

System Overview
The System Overview page gives a quick look over the camera’s status and settings. 
Information that can be found here includes the camera’s Firmware version, IP address, 
Security, Optional Network Services, Event Settings, Image settings and Recent log 
items. Many of the captions are also links to the proper Setup page to conveniently 
make adjustments in the camera’s settings.

Logs & Reports
When contacting Axis support, please be sure to provide a valid Server Report with your 
query.
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View Information - The Logs report and the Parameter List also provide valuable 
information for troubleshooting and when contacting Axis’ support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis network 
camera configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.

About

Third Party Software Licenses - click View licenses for a list of the licensed software used 
in the AXIS 231D+/232D+ Network Dome Camera.

 

Resetting to Factory Default Settings

To reset the AXIS 231D+/232D+ to the original default settings, go to the System Options 
> Maintenance web page (described in Maintenance, on page 47) or use the control button 
on the AXIS 231D+/232D+ as described below:
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Using the Control Button

Follow the instructions below to reset the AXIS 231D+/232D+ to factory default settings 
using the Control Button.

1. Switch off the AXIS 231D+/232D+ 
by disconnecting the power.

2. Press and hold the Control button 
while you reconnect the power.

3. Keep the Control button pressed 
until the Power Indicator flashes 
amber (this may take up to 15 
seconds).

4. Release the Control button.

5. When the Power Indicator changes 
to green (may take up to 1 minute), the process is complete and the AXIS 
231D+/232D+ has been reset.

Control button

Network Indicator

Power Indicator
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Connection Module
This section describes the pinout provided by the Connection module consisting of: 

24V AC Power

used

4 transistor outputs

(see table below)
4 digital inputs

not 

 

• 4 transistor outputs
• 4 digital inputs
• power and GND (ground)

 

 

The inputs/outputs are used in applications for, e.g. event triggering, time lapse recording, 
alarm notification via email, picture storage to FTP locations.

• Input - e.g. a doorbell. If the doorbell is pressed, the state changes, and the input 
will be active (shown under Event Configuration > Port Status). 

• Output - e.g. an alarm device that can be activated from Output buttons from the 
Live View page or as an action to an Event Type. The output will show as active 
(under Event Configuration > Port Status), if the alarm device is activated.

Connection Module Pinout

1. Loosen the corresponding screw on top of the pin (see the table above to determine 
which pin to use).

2. Push the cable into the connector and secure it by fastening the screw.

Function Description Function Description

n/a not used GND ground

n/a not used GND ground

n/a not used Transistor Output 4 See below

n/a not used Digital Input 4 See below

n/a not used Transistor Output 3 See below

n/a not used Digital Input 3 See below

n/a not used Transistor Output 2 See below

PS GND ground Transistor Output 1 See below

24 VAC 24 VAC Digital Input 2 See below

24 VAC 24 VAC Digital Input 1 See below

Digital Input (1-4)- connect to GND to activate or leave floating (unconnected) to deactivate

Transistor Output (1-4)- Max. load 100mA, max. voltage 24V DC. An open-collector NPN transistor with 
the emitter connected to pin 2 (GND). If used with an external relay, a diode must be connected in parallel 
with the load for protection against any voltage transients.
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o

o

3.3V

e.g. doorbell

o

o

o

o

o

o

o

Switch 
Mode

o

GND

IN 1

IN 2

IN 3

IN 4
OUT 1

OUT 2

OUT 3

OUT 4

24VAC

GND

24VAC Power~

~
supply

PS GND o

Schematic Diagram - AXIS 231D+/232D+ I/O connectors and power

Note: Unmarked I/O connectors on the connection module can not be used.
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Troubleshooting

Checking the Firmware

One of your first actions when troubleshooting a problem should be to check the currently 
installed firmware version. The latest version may contain a correction that fixes your 
particular problem. See the support section at http://www.axis.com/techsup for 
information on the latest available firmware version. The current software version in your 
AXIS 231D+/232D+ is available from the product Web pages under Setup > Basic 
Configuration.

Updating the Firmware

The firmware is software that determines the functionality of the AXIS 231D+/232D+. 
When you upgrade to the latest available firmware from the Axis Web site, your Axis 
product will receive the latest available functionality. Always read the upgrade instructions 
and release notes available with each new release, before upgrading the firmware.

New firmware can be uploaded to the AXIS 231D+/232D+ over the network.

Note: Preconfigured and customized settings will be retained for use when the new firmware is running (provid-
ing that the features are available in the new firmware) although this is not guaranteed by Axis Communi-
cations.

1. Save the firmware file to your computer. The latest version of the AXIS 
231D+/232D+ firmware is available free of charge from the Axis Web site at 
http://www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the AXIS 231D+/232D+ Web 
pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: After starting the process, you should always wait at least 20 minutes before restarting the AXIS 
231D+/232D+, even if you suspect the procedure has failed.

Your dealer reserves the right to charge for any repair attributable to faulty updating by the user.
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Emergency Recovery Procedure
If power or the network connection to the AXIS 231D+/232D+ is lost during the upgrade, 
the process will fail and the unit will become unresponsive. A flashing red Network LED 
indicates a failed upgrade. To recover the unit, follow the steps below. The serial number is 
found on the label on the product casing.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of AXIS 231D+/232D+> <Serial number> temp 
ping -s 408 <IP address of AXIS 231D+/232D+> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of AXIS 231D+/232D+> <Serial number> 
ping -l 408 -t <IP address of AXIS 231D+/232D+>

Note: the ping -l command is the lower-case letter (L) 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 231D+/232D+’s IP address. In the page that 
appears, use the Browse button to select the upgrade file to use, e.g. axis231d.bin or 
axis232d.bin. Then click the Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green on the Power LED and flashing green or amber on the Network 
LED. 

5. Reinstall the AXIS 231D+/232D+. 

If the emergency recovery procedure does not get the AXIS 231D+/232D+ up and running 
again, please contact Axis support at www.axis.com/techsup/ 

Support

If you contact Axis Customer Services, please help us help you resolve your problems 
expediently by providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP Ping The IP address must be set within two minutes after the power has been applied to the AXIS 
231D+/232D+, restart the server and try again. Also, make sure the ping length is set to 408. 
See the ARP ping description in the Installation Guide.

The AXIS 231D+/232D+ is 
located on a different subnet.

If the IP address intended for the AXIS 231D+/232D+ and the IP address of your computer are 
located on different subnets, you will not be able to set the IP address. Contact your network 
administrator for an IP address on the same subnet as the computer you are performing the 
installation from.

The IP address is being used by 
another device

Disconnect the power from the AXIS 231D+/232D+.  
Run the Ping command (in a Command/DOS window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
AXIS 231D+/232D+. In this case, check all cabling and reinstall the unit.

The AXIS 231D+/232D+ cannot be accessed from a Web browser
Cannot log in. If the AXIS 231D+/232D+ has been configured to use HTTPS, check that the protocol in the URL 

used to access the unit is correct. You may need to type this in manually (i.e. http or https) in 
the browser’s address field.

The IP address has been changed 
by DHCP

1) Move the AXIS 231D+/232D+ to an isolated network or to one with no DHCP or BOOTP 
server. Set the IP address again, using AXIS IP Utility or the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Cannot access web page Empty the temporary cache of your web browser.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The AXIS 231D+/232D+ can be configured to use a SOCKS server to reach networks on the 

other side of a firewall/proxy server. See  SOCKS, on page 44 for more information.

Your AXIS 231D+/232D+ is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings, and check the subnet mask.

The Internet site is too heavily 
loaded

Use a script running on your web server to relay images from the AXIS 231D+/232D+ to the 
Internet. 

The Power indicator is not constantly lit
Faulty power supply Verify that you are using the correct power supply.

A firmware upgrade has been 
interrupted or the firmware has 
in some other way been dam-
aged.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping,

Then, from a Web browser, access the unit and upgrade the latest firmware to the product, see 
Updating the Firmware, on page 52.

No images are displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 
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For additional assistance, please contact your reseller or check the product’s support pages 
on the Axis Website at http://www.axis.com/techsup

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure yourAXIS 231D+/232D+ to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See help files for more 
information.

Video Image Problems
Image too dark or too light. See the help files on Video & Image Settings

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space.

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring, e.g. pre-buffers, hi-res images, high frame rate etc will reduce the performance of 
the AXIS 231D+/232D+. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, many users with access to unit, 
low performing client, use of features such as Event handling., Image rotation, and applications 
such as an antivirus program.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
AXIS 231D+/232D+ are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your ISP and router support multicasting, or if the router settings between the client 
and the server need to be configured. The TTL (Time To Live) value may need to be increased.

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

Unexpected PTZ behavior
Problem with hardware Go to System Options > Maintenance > Dome Status and click Test to test the camera and 

dome mechanics for errors. Contact Axis Customer Services if you receive an error message as 
the result of this test.



 56 AXIS 231D+/232D+ - Technical Specifications
Technical Specifications

Item Specification

Models • AXIS 231D+ 50 Hz/PAL
• AXIS 231D+ 60 Hz/NTSC
• AXIS 232D+ 50 Hz/PAL (Automatic day/night)
• AXIS 232D+ 60 Hz/NTSC (Automatic day/night) 

Image sensor • 1/4” Sony EXview HAD CCD 

Lens • F1.4-3.0
• f=4.1 mm wide to 73.8 mm tele 
• autofocus
• Focus range: 35 mm (wide) or 800 mm (tele) to infinity

Angle of view • 2.8º - 48º Horizontal 

Zoom • 18x optical, 12x digital

Minimum illumination • Color: 0.3 lux at 30IRE
• B/W: 0.005 lux at 30IRE (Only AXIS 232D+) 

Pan Range • 360º endless 

Tilt Range • 0º - 90º 

Max speed • Pan 360º/s
• Tilt 360º/s 

Video compression • Motion JPEG
• MPEG-4 Part 2 (ISO/IEC 14496-2), Profiles: ASP and SP

Resolutions • 4CIF, 2CIF Expanded, 2CIF, CIF, QCIF
• Maximum 768x576 (PAL) 704x480 (NTSC)
• Minimum 176x144 (PAL) 160x120 (NTSC)

Frame rate (NTSC/PAL) • Motion JPEG: Up to 30/25 fps in all resolutions
• MPEG-4: Up to 25/21 fps at 4CIF/2CIFExp 

Up to 30/25 fps at 2CIF/CIF/QCIF 

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and bandwidth
• Constant and variable bit rate (MPEG-4) 

Image settings • Compression levels: 11 (Motion JPEG)/23 (MPEG-4)
• Configurable brightness, sharpness, white balance, exposure control, and 

backlight compensation
• Overlay capabilities: time, date, text, custom logo or image
• De-interlacing (4CIF resolution) 

PTZ control • 50 preset positions
• Guard tour
• Control queue
• Supports Windows compatible joysticks

Shutter time • 1 sec to 1/10.000 sec

Security • Multiple user access levels with password protection
• IP address filtering
• HTTPS encryption
• IEEE 802.1X authentication
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Alarm and event 
mangagement

• Events triggered by video motion detection, PTZ preset position, external inputs, or 
according to a schedule

• Image upload over FTP,email and HTTP
• Notification over TCP, email, HTTP, and external outputs
• Pre- and post alarm buffer of 9 MB per channel

Connectors • Ethernet 10BaseT/100BaseTX, RJ-45
• 4 alarm inputs
• 4 outputs 

Processors and memory • CPU: ETRAX 100LX 32bit
• Video processing and compression: ARTPEC-2
• Memory: 32 MB RAM, 8 MB Flash
• Battery backed up real-time clock 

Power • 19 - 28 VAC, max 25 VA
• 24 - 40 VDC, max 20 W

Operating conditions • 5 - 50 ºC (41 – 122 ºF)
• Humidity 20 - 80% RH (non-condensing) 

Installation, management 
and maintenance 

• AXIS Camera Management tool on CD and web-based configuration
• Configuration of backup and restore
• Firmware upgrades over HTTP or FTP, firmware available at www.axis.com 

Video access from Web 
browser 

• Camera live view
• Video recording to file (ASF)
• Sequence tour for up to 20 PTZ presets or Axis video sources
• Customizable HTML pages 

Minimum Web browsing 
requirements 

• Pentium III CPU 500 MHz or higher, or equivalent AMD,128 MB RAM, AGP 
graphics card 32 MB RAM, Direct Draw

• Windows XP, 2000, DirectX 9.0 or later Internet Explorer 6.x or later
• For other operating systems and browsers see www.axis.com/techsup 

System integration 
support 

• Open API for software integration available at www.axis.com
•  including AXIS VAPIX API
•  AXIS Media Control SDK
•  event trigger data in video stream
• PTZ control with Windows compatible Joystick
• Quality of Service (QoS) Layer 3, DiffServ Model
• Embedded operating system: Linux

Supported protocols IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP, IGMP, 
RTCP, SMTP, FTP, ICMP DHCP, UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS, IEEE802.1X. 
More information on protocol usage available at www.axis.com 
 
*This product includes software developed by the Open SSL Project for use in the 
Open SSL Tool kit (www.openssl.org)

Item Specification
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Included accessories • Power supply: 24 V AC, 1.5 A
• Hard ceiling mounting bracket
• Drop ceiling mounting bracket
• Transparent bubble
• CD with intallation tool, software,
• User manual, MPEG-4 licenses (1 encoder, 1 decorder)
• MPEG-4 decoder (Windows)
• Quick installation guide
• Connection module for power and alarm in/out 

Video management 
software (not incl.)

• AXIS Camera Station - Surveillance application for viewing, recording and 
archiving up to 25 cameras

• See www.axis.com/partner/adp_partners.htm for more software applications via 
partners 

Accessories (not incl.) • Housings for adverse indoor/outdoor environments
• Smoked bubble
• Outdoor IP66 rated power supply AXIS PS24
• IR Illumination (Only AXIS 232D+)
• AXIS 295 Video Surveillance Joystick
• AXIS 292 Network Video Decoder
• MPEG-4 Decoder multi-user license pack

Approvals •  EN 55022 Class A,
•  EN 61000-3-2,
•  EN 61000-3-3,
•  EN 55024,
•  FCC Part 15 Subpart B Class A,
•  ICES-003 Class A,
•  VCCI Class A,
•  C-tick AS/NZS CISPR 22 Class A,
•  EN 60065
• Power supply: EN 60950, UL, CSA

Dimensions  and weight • 225 x 144 x 144 mm (8.9” x 5.7” x 5.7”)
• 1.8 kg (4.0 lbs) excluding power supply

Item Specification
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General performance considerations

When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected.
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
231D+/232D+ provides a tool that can be used to display these values directly in the video 
image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps) 
bandwidth in Kbps) to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 

Important!
• The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

• For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.
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Frame rates - Motion JPEG 

The following test results show the frame rates in frames/second (fps) for Motion JPEG 
streams from the AXIS 231D+/232D+, using a compression level of 50%. Note that these 
values are guidelines only - actual values may vary.

Frame rates - MPEG-4

The following test results show the frame rates in frames/second (fps) for MPEG-4 streams 
from the AXIS 231D+/232D+. Note that these values are guidelines only - actual values 
may vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP*

*Note that setting the GOV structure to use “I-frames only” will increase the frame rate. 

Bandwidth

As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure

fps (NTSC/PAL) 
4CIF 30/25

2CIF expanded 30/25
2CIF 30/25
CIF 30/25

QCIF 30/25

fps (NTSC) fps (PAL)
4CIF 25 21

2CIF expanded 25 21
2CIF 30 25
CIF 30 25

QCIF 30 25
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There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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Glossary of Terms
ActiveX - A standard that enables software components to 
interact with one another in a networked environment, 
regardless of the language(s) used to create them. Web 
browsers may come into contact with ActiveX controls, 
ActiveX documents, and ActiveX scripts. ActiveX controls 
are often downloaded and installed automatically as 
required. 

AF (Autofocus) - A system by which the camera lens 
automatically focuses on a selected part of the subject. 

Angle - The field of view, relative to a standard lens in a 
35mm still camera, expressed in degrees, e.g. 30°. For 
practical purposes, this is the area that a lens can cover, 
where the angle of view is determined by the focal length of 
the lens. A wide-angle lens has a short focal length and 
covers a wider angle of view than standard or telephoto 
lenses, which have longer focal lengths.

ARP (Address Resolution Protocol) - This protocol is used 
to associate an IP address to a hardware MAC address. A 
request is broadcast on the local network to discover the 
MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - A chip 
designed by Axis for image compression. ARTPEC supports 
a range of CCD and CMOS sensors, built-in functionality for 
sharpening, backlight compensation, noise reduction and 
white balance, support for multiple Motion-JPEG streams,  
support for MPEG-4 part 2, up to 30 frames/second from 4 
simultaneous video sources and real-time compression of up 
to 45 Megapixels/second. 

ASIC (Application Specific Integrated Circuit) - A circuit 
designed for a specific application, as opposed to a general 
purpose circuit, such as a microprocessor. 

Aspect ratio - A ratio of width to height in images. A 
common aspect ratio used for television screens and 
computer monitors is 4:3. High-definition television (HDTV) 
uses an aspect ratio of 9:16.

Autoiris (or DC-Iris) - This special type of iris is electrically 
controlled by the camera, to automatically regulate the 
amount of light allowed to enter.

AVI (Audio Video Interleave) - A video format that 
supports simultaneous playback of audio and video. 

Bitmap - A bitmap is a data file representing a rectangular 
grid of pixels. It defines a display space and color for each 
pixel (or "bit") in the display space. This type of image is 
known as a "raster graphic." GIF's and JPEG's are examples 
of image file types that contain bitmaps. 

Because a bitmap uses this fixed raster method, it cannot 
easily be rescaled without losing definition. Conversely, a 
vector graphic image uses geometrical shapes to represent 
the image, and can thus be quickly rescaled. 

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred 

to as speed, but actually defines the number of bits/time 
unit and not distance/time unit. 

Bluetooth - Bluetooth is an open standard for wireless 
transmission of voice and data between mobile devices (PCs, 
handheld computers, telephones and printers).

Bonjour - Also known as zero-configuration networking, 
Bonjour enables devices to automatically discover each 
other on a network, without having to enter IP addresses or 
configure DNS servers. Bonjour is a trademark of Apple 
Computer, Inc.

Broadband - In network engineering terms, this describes 
transmission methods where two or more signals share the 
same carrier. In more popular terminology, broadband is 
taken to mean high-speed data transmission. 

CCD (Charged Coupled Device) - This light-sensitive image 
device used in many digital cameras is a large integrated 
circuit that contains hundreds of thousands of photo-sites 
(pixels) that convert light energy into electronic signals. Its 
size is measured diagonally and can be 1/4”, 1/3", 1/2" or 
2/3". 

CGI (Common Gateway Interface) - A specification for 
communication between a web server and other (CGI) 
programs. For example, a HTML page that contains a form 
might use a CGI program to process the form data once it is 
submitted.

CIF (Common Intermediate Format) - CIF refers to the 
analog video resolutions 352x288 pixels (PAL) and 352x240 
pixels (NTSC). See also Resolution.

Client/Server - Client/server describes the relationship 
between two computer programs in which one program, the 
client, makes a service request from another program, the 
server, which fulfils the request. Typically, multiple client 
programs share the services of a common server program. A 
web browser is a client program that requests services (the 
sending of web pages or files) from a web server.

CMOS (Complementary Metal Oxide Semiconductor) - A 
CMOS is a widely used type of semiconductor that uses both 
negative and positive circuits. Since only one of the circuit 
types is on at any given time, CMOS chips require less 
power than chips using just one type of transistor. CMOS 
image sensors also allow processing circuits to be included 
on the same chip, an advantage not possible with CCD 
sensors, which are also much more expensive to produce.

Codec - In communications engineering, a codec is usually 
a coder/decoder. Codecs are used in integrated circuits or 
chips that convert e.g. analog video and audio signals into a 
digital format for transmission. The codec also converts 
received digital signals back into analog format. A codec 
uses analog-to-digital conversion and digital-to-analog 
conversion in the same chip. 

Codec can also mean compression/decompression, in which 
case it is generally taken to mean an algorithm or computer 
program for reducing the size of large files and programs.
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Compression - See Image Compression.

Contrast  - Defines the degree of difference between the 
lightest and darkest parts of an image or video stream.

DC-Iris - This special type of iris is electrically controlled 
by the camera, to automatically regulate the amount of light 
allowed to enter.

DHCP (Dynamic Host Configuration Protocol) - DHCP is a 
protocol that lets network administrators automate and 
centrally manage the assignment of Internet Protocol (IP) 
addresses to network devices in a network. 

DHCP uses the concept of a "lease" or amount of time that a 
given IP address will be valid for a computer. The lease time 
can vary, depending on how long a user is likely to require 
the network connection at a particular location. 

DHCP also supports static addresses for e.g. computers 
running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and 
translate Internet domain names into IP (Internet Protocol) 
addresses. A domain name is a meaningful and 
easy-to-remember name for an Internet address. For 
example the domain name www.example.com is much 
easier to remember than 192.0.34.166. The translation tables 
for domain names are contained in Domain name servers.

Domain Server - Domains can also be used by 
organizations who wish to centralize the management of 
their (Windows) computers. Each user within a domain has 
an account that usually allows them to log in to and use any 
computer in the domain, although restrictions may also 
apply. The domain server is the server that authenticates the 
users on the network. 

Duplex - See Full-duplex.

Ethernet - Ethernet is the most widely installed local area 
network technology. An Ethernet LAN typically uses special 
grades of twisted pair wires. The most commonly installed 
Ethernet systems are 10BASE-T and 100BASE-T10, which 
provide transmission speeds up to 10 Mbps and 100 Mbps 
respectively. 

ETRAX (Ethernet Token Ring AXIS) - Axis' own 
microprocessor.

Factory default settings - These are the settings that 
originally applied for a device when it was first delivered 
from the factory. If it should become necessary to reset a 
device to its factory default settings, this will, for many 
devices, completely reset any settings that were changed by 
the user. 

Firewall - A firewall works as a barrier between networks, 
e.g. between a Local Area Network and the Internet. The 
firewall ensures that only authorized users are allowed to 
access the one network from the other. A firewall can be 
software running on a computer, or it can be a standalone 
hardware device. 

Focal length  - Measured in millimeters, the focal length of 

a camera lens determines the width of the horizontal field of 
view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - An application protocol that 
uses the TCP/IP protocols. It is used to exchange files 
between computers/devices on networks. 

Frame - A frame is a complete video image. In the 2:1 
interlaced scanning format of the RS-170 and CCIR formats, 
a frame is made up of two separate fields of 262.5 or 312.5 
lines interlaced at 60 or 50 Hz to form a complete frame, 
which appears at 30 or 25 Hz. In video cameras with a 
progressive scan, each frame is scanned line-by-line and not 
interlaced; most are also displayed at 30 and 25 Hz.

Frame rate - The frame rate used to describe the frequency 
at which a video stream is updated is measured in frames 
per second (fps). A higher frame rate is advantageous when 
there is movement in the video stream, as it maintains 
image quality throughout.

Full-duplex - Transmission of data in two directions 
simultaneously. In an audio system this would describe e.g. 
a telephone systems. Half-duplex also provides 
bi-directional communication, but only in one direction at a 
time, as in a walkie-talkie system. See also Simplex.

Gain - Gain is the amplification factor and the extent to 
which an analog amplifier boosts the strength of a signal. 
Amplification factors are usually expressed in terms of 
power. The decibel (dB) is the most common way of 
quantifying the gain of an amplifier. 

Gateway - A gateway is a point in a network that acts as an 
entry point to another network. In a corporate network for 
example, a computer server acting as a gateway often also 
acts as a proxy server and a firewall server. A gateway is 
often associated with both a router, which knows where to 
direct a given packet of data that arrives at the gateway, and 
a switch, which furnishes the actual path in and out of the 
gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the 
most common file formats used for images in web pages. 
There are two versions of the format, 87a and 89a. Version 
89a supports animations, i.e. a short sequence of images 
within a single GIF file. A GIF89a can also be specified for 
interlaced presentation.

GOV (Group Of VOPs) - A group of VOP's is the basic unit 
of an MPEG-4 video stream. The GOV contains different 
types and numbers of VOP's (I-VOP's, P-VOP's, etc.) as 
determined by the GOV length and GOV structure. See also 
VOP.

GOV length - The GOV length determines the number of 
images (VOP's) in the GOV structure. See also GOV and 
VOP.

GOV structure - The GOV structure describes the 
composition of an MPEG-4 video stream, as regards the type 
of images (I-VOP's or P-VOP's) included in the stream, and 
their internal order. See also GOV and VOP.
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Half-duplex - See Full-duplex. 

HTML (Hypertext Markup Language) - HTML is the set of 
"markup" symbols or codes inserted in a file intended for 
display in web browser. The markup tells the browser how 
to display the page's words and images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of 
rules for exchanging files (text, graphic images, sound, 
video, and other multimedia files) on the web. The HTTP 
protocol runs on top of the TCP/IP suite of protocols.

Hub - A (network) hub is used to connect multiple devices 
to the network. The hub transmits all data to all devices 
connected to it, whereas a switch will only transmit the data 
to the device it is specifically intended for.

IEEE 802.11 - A family of standards for wireless LANs. The 
802.11 standard supports 1 or 2 Mbit/s transmission on the 
2.4 GHz band. IEEE 802.11b specifies an 11 Mbit/s data rate 
on the 2.4 GHz band, while 802.11a allows up to 54 Mbit/s 
on the 5 GHz band.

Image compression - Image compression minimizes the file 
size (in bytes) of an image. Two of the most common 
compressed image formats are JPEG and GIF.

Interlacing - Interlaced video is video captured at 50 
pictures (known as fields) per second, of which every 2 
consecutive fields (at half height) are then combined into 1 
frame. Interlacing was developed many years ago for the 
analog TV world and is still used widely today. It provides 
good results when viewing motion in standard TV pictures, 
although there is always some degree of distortion in the 
image.

To view interlaced video on e.g. a computer monitor, the 
video must first be de-interlaced, to produce progressive 
video, which consists of complete images, one after the 
other, at 25 frames per second. See also Progressive scan. 

IP (Internet Protocol) - The Internet Protocol is a method 
transmitting data over a network. Data to be sent is divided 
into individual and completely independent "packets." Each 
computer (or host) on the Internet has at least one address 
that uniquely identifies it from all others, and each data 
packet contains both the sender's address and the receiver's 
address. 

The Internet Protocol ensures that the data packets all arrive 
at the intended address. As IP is a connectionless protocol, 
which means that there is no established connection 
between the communication end-points, packets can be sent 
via different routes and do not need to arrive at the 
destination in the correct order. 

Once the data packets have arrived at the correct 
destination, another protocol - Transmission Control 
Protocol (TCP) - puts them in the right order. See also TCP.

IP Address - An IP address is simply an address on an IP 
network used by a computer/device connected to that 
network. IP addresses allow all the connected 
computers/devices to find each other and to pass data back 

and forth. 

To avoid conflicts, each IP address on any given network 
must be unique. An IP address can be assigned as fixed, so 
that it does not change, or it can be assigned dynamically 
(and automatically) by DHCP. 

An IP address consists of four groups (or quads) of decimal 
digits separated by periods, e.g. 130.5.5.25. Different parts 
of the address represent different things. Some part will 
represent the network number or address, and some other 
part will represent the local machine address. 

See also IP (Internet Protocol).

Infrared (IR) - Infrared radiation is radiation at a longer 
wavelength than visible light, which means it cannot be 
seen by the naked human eye. As infrared radiation can be 
detected as heat, this can be shown on a screen or captured 
by a digital camera, with hotter objects showing up brighter 
against colder surroundings (e.g. a human body against a 
colder background). 

As color cameras can "see" infrared radiation as well as 
visible light, these cameras are equipped with an IR-cut 
filter, to prevent distortion of the colors the human eye can 
see. To use the camera in very dark locations or at night, 
this filter can be removed, to allow infrared radiation to hit 
the image sensor and thus produce images. 

An infrared lamp can be used for improved illumination for 
night surveillance, whilst not producing any extra visible 
light. 

Inputs/Outputs (I/O's) - The digital I/Os on, for example, a 
network camera can be used to connect any device that can 
toggle between an open and a closed circuit. 

If, for example, a door switch is used as an input device, 
opening the door could trigger the upload of video images 
and the sending of notification messages. 

An output might, for example, be used to automatically 
start a siren when there is a motion detection trigger.

I-VOP - See VOP.

JPEG (Joint Photographic Experts Group) - Together with 
the GIF file format, JPEG is an image file type commonly 
used on the web. A JPEG image is a bitmap, and usually has 
the file suffix '.jpg' or ".jpeg." When creating a JPEG image, 
it is possible to configure the level of compression to use. As 
the lowest compression (i.e. the highest quality) results in 
the largest file, there is a trade-off between image quality 
and file size. 

kbit/s (kilobits per second) - A measure of the bit rate, i.e. 
the rate at which bits are passing a given point. See also Bit 
rate.

LAN (Local Area Network) - A LAN is a group of 
computers and associated devices that typically share 
common resources within a limited geographical area.

Linux - Linux is an open source operating system within 
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the Unix family. Because of its robustness and availability, 
Linux has won popularity in the open source community 
and among commercial application developers.

MAC address (Media Access Control address) - A MAC 
address is a unique identifier associated with a piece of 
networking equipment, or more specifically, its interface 
with the network. For example, the network card in a 
computer has its own MAC address. 

Manual iris - This is the opposite to an autoiris, i.e. the 
camera iris must be adjusted manually to regulate the 
amount of light allowed to reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate, 
i.e. the rate at which bits are passing a given point. 
Commonly used to give the "speed" of a network. A LAN 
might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a standard television 
set, but lacks the electronics to pick up regular television 
signals.

Motion JPEG - Motion JPEG is a simple 
compression/decompression technique for networked video. 
Latency is low and image quality is guaranteed, regardless 
of movement or complexity of the image. Image quality is 
controlled by adjusting the compression level, which in turn 
provides control over the file size, and thereby the bit rate. 

High-quality individual images from the Motion JPEG 
stream are easily extracted. See also JPEG.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) -  The Moving 
Picture Experts Group develops standards for digital video 
and audio compression. It operates under the auspices of the 
International Organization for Standardization (ISO). The 
MPEG standards are an evolving series, each designed for a 
different purpose.

MPEG-2 - MPEG-2 is the designation for a group of audio 
and video coding standards, and is typically used to encode 
audio and video for broadcast signals, including digital 
satellite and Cable TV. MPEG-2, with some modifications, is 
also the coding format used by standard commercial DVD 
movies.

MPEG-4 - MPEG-4 is a group of audio and video coding 
standards and related technology. The primary uses for the 
MPEG-4 standard are web (streaming media) and CD 
distribution, conversational (videophone), and broadcast 
television.

Most of the features included in MPEG-4 are left to 
individual developers to decide whether to implement them 
or not. This means that there are probably no complete 
implementations of the entire MPEG-4 set of standards. To 
deal with this, the standard includes the concept of 
"profiles" and "levels", allowing a specific set of capabilities 
to be defined in a manner appropriate for a subset of 
applications.

Multicast - Bandwidth-conserving technology that reduces 
bandwidth usage by simultaneously delivering a single 
stream of information to multiple network recipients. 

Multiplexer - A multiplexer is a high-speed switch that 
provides full-screen images from up to 16 analog cameras. 
Multiplexers can playback everything that happened on any 
one camera with no interference from the other cameras on 
the system.

Network connectivity - The physical (wired or wireless) 
and logical (protocol) connection of a computer network or 
an individual device to a network, such as the Internet or a 
LAN.

NWay - NWay is a telecommunications protocol used with 
Ethernet networking devices (such as router and switch) to 
automatically negotiate the highest possible common 
transmission speed between two devices.

NTSC (National Television System Committee) - NTSC is 
the television and video standard in the United States. NTSC 
delivers 525 lines at 60 half-frames/second.

OEM (Original Equipment Manufacturer) - This is a 
designation for companies that manufacture equipment 
which is then marketed and sold to other companies under 
their own names.

PAL (Phase Alternating Line) - PAL is the dominant 
television standard in Europe. PAL delivers 625 lines at 50 
half-frames/second.

PEM (Privacy Enhanced Mail) - An early standard for 
securing electronic mail. The PEM-format is often used for 
representing an HTTPS certificate or certificate request.

Ping  - Ping is a basic network program used diagnostically 
to check the status of a network host or device. Ping can be 
used to see if a particular network address (IP address or 
host name) is occupied or not, or if the host at that address 
is responding normally. Ping can be run from e.g. the 
Windows Command prompt or the command line in Unix.

Pixel (Picture element) - A pixel is one of the many tiny 
dots that make up a digital image. The color and intensity of 
each pixel represents a tiny area of the complete image. 

PoE (Power over Ethernet) - Power over Ethernet provides 
power to a network device via the same cable as used for the 
network connection. This is very useful for IP-Surveillance 
and remote monitoring applications in places where it may 
be too impractical or expensive to power the device from a 
power outlet. 

PPP (Point-to-Point Protocol) - A protocol that uses a 
serial interface for communication between two network 
devices. For example, a PC connected by a phone line to a 
server. 

PPTP (Point-to-Point Tunnelling Protocol) - A protocol 
(set of communication rules) that allows corporations to 
extend their own corporate network through private 
"tunnels" over the public Internet. In this way a corporation 
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can effectively use a WAN (Wide Area Network) as a large 
single LAN (Local Area Network). This kind of 
interconnection is known as a virtual private network 
(VPN). 

Pre/post alarm images - The images from immediately 
before and after an alarm. These images are stored in a 
buffer for later retrieval.

Progressive scan - Progressive scan, as opposed to 
interlaced video, scans the entire picture, line by line every 
sixteenth of a second. In other words, captured images are 
not split into separate fields as in interlaced scanning. 

Computer monitors do not need interlace to show the 
picture on the screen, but instead show them progressively, 
on one line at a time in perfect order, i.e. 1, 2, 3, 4, 5, 6, 7 
etc., so there is virtually no "flickering" effect. In a 
surveillance application, this can be critical when viewing 
detail within a moving image, such as a person running. A 
high-quality monitor is required to get the best from 
progressive scan. See also Interlacing.

Protocol - A special set of rules governing how two entities 
will communicate. Protocols are found at many levels of 
communication, and there are hardware protocols and 
software protocols. 

Proxy server - In an organization that uses the Internet, a 
proxy server acts as an intermediary between a workstation 
user and the Internet. This provides security, administrative 
control, and a caching service. Any proxy server associated 
with a gateway server, or part of a gateway server, 
effectively separates the organization’s network from the 
outside network and the local firewall. It is the firewall 
server that protects the network against outside intrusion. 

A proxy server receives requests for Internet services (such 
as web page requests) from many users. If the proxy server 
is also a cache server, it looks in its local cache of 
previously downloaded web pages. If it finds the page, it is 
returned to the user without forwarding the request to the 
Internet. If the page is not in the cache, the proxy server, 
acting as a client on behalf of the user, uses one of its own 
IP addresses to request the page from another server over 
the Internet. When the requested page is returned, the proxy 
server forwards it to the user that originally requested it. 

P-VOP - See VOP.

Resolution - Image resolution is a measure of how much 
detail a digital image can hold: the greater the resolution, 
the greater the level of detail. Resolution can be specified as 
the number of pixel-columns (width) by the number of 
pixel-rows (height), e.g. 320x240. 

Alternatively, the total number of pixels (usually in 
megapixels) in the image can be used. In analog systems it 
is also common to use other format designations, such as 
CIF, QCIF, 4CIF, etc.

RTCP (Real-Time Control Protocol) - RTCP provides 
support for real-time conferencing of groups of any size 

within an intranet. This support includes source 
identification and support for gateways like audio and video 
bridges as well as multicast-to-unicast translators.

RTCP offers quality-of-service feedback from receivers to 
the multicast group as well as support for the 
synchronization of different media streams. 

RTP (Real-Time Transport Protocol) - RTP is an Internet 
protocol for the transport of real-time data, e.g. audio and 
video. It can be used for media-on-demand as well as 
interactive services such as Internet telephony. 

RTSP (Real Time Streaming Protocol) - RTSP is a control 
protocol, and a starting point for negotiating transports 
such as RTP, multicast and Unicast, and for negotiating 
codecs. 

RTSP can be considered a "remote control" for controlling 
the media stream delivered by a media server. RTSP servers 
typically use RTP as the protocol for the actual transport of 
audio/video data.

Router - A device that determines the next network point to 
which a packet should be forwarded on its way to its final 
destination. A router creates and/or maintains a special 
routing table that stores information on how best to reach 
certain destinations. A router is sometimes included as part 
of a network switch. See also switch.

Server - In general, a server is a computer program that 
provides services to other computer programs in the same or 
other computers. A computer running a server program is 
also frequently referred to as a server. In practice, the server 
may contain any number of server and client programs. A 
web server is the computer program that supplies the 
requested HTML pages or files to the client (browser). 

Sharpness - This is the control of fine detail within a 
picture. This feature was originally introduced into color TV 
sets that used notch filter decoders. This filter took away all 
high frequency detail in the black and white region of the 
picture. The sharpness control attempted to put some of that 
detail back in the picture. Sharpness controls are mostly 
superfluous in today's high-end TVs. The only logical 
requirement for it nowadays is on a VHS machine. 

Simplex - In simplex operation, a network cable or 
communications channel can only send information in one 
direction.

SMTP (Simple Mail Transfer Protocol) - SMTP is used for 
sending and receiving e-mail. However, as it is "simple," it 
is limited in its ability to queue messages at the receiving 
end, and is usually used with one of two other protocols, 
POP3 or IMAP. These other protocols allow the user to save 
messages in a server mailbox and download them 
periodically from the server. 

SMTP authentication is an extension of SMTP, whereby the 
client is required to log into the mail server before or during 
the sending of email. It can be used to allow legitimate users 
to send email while denying the service to unauthorized 
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users, such as spammers. 

SNMP (Simple Network Management Protocol) - SNMP 
forms part of the Internet Protocol suite, as defined by the 
Internet Engineering Task Force. The protocol can support 
monitoring of network-attached devices for any conditions 
that warrant administrative attention.

Sockets - Sockets are a method for communication between 
a client program and a server program over a network. A 
socket is defined as "the endpoint in a connection." Sockets 
are created and used with a set of programming requests or 
"function calls" sometimes called the sockets application 
programming interface (API). 

SSL/TSL (Secure Socket Layer/Transport Layer Security)

These two protocols (SSL is succeeded by TSL) are 
cryptographic protocols that provide secure communication 
on a network. SSL is commonly used over HTTP to form 
HTTPS, as used e.g. on the Internet for electronic financial 
transactions. SSL uses public key certificates to verify the 
identity of the server. 

Subnet & subnet mask - A subnet is an identifiably 
separate part of an organization's network. Typically, a 
subnet may represent all the machines at one geographic 
location, in one building, or on the same local area network 
(LAN). Having an organization's network divided into 
subnets allows it to be connected to the Internet with a 
single shared network address.

The subnet mask is the part of the IP address that tells a 
network router how to find the subnet that the data packet 
should be delivered to. Using a subnet mask saves the router 
having to handle the entire 32-bit IP address; it simply looks 
at the bits selected by the mask.

Switch - A switch is a network device that connects 
network segments together, and which selects a path for 
sending a unit of data to its next destination. In general, a 
switch is a simpler and faster mechanism than a router, 
which requires knowledge about the network and how to 
determine the route. Some switches include the router 
function. See also Router.

TCP (Transmission Control Protocol) - TCP is used along 
with the Internet Protocol (IP) to transmit data as packets 
between computers over the network. While IP takes care of 
the actual packet delivery, TCP keeps track of the individual 
packets that the communication (e.g. requested a web page 
file) is divided into, and, when all packets have arrived at 
their destination, it reassembles them to re-form the 
complete file.

TCP is a connection-oriented protocol, which means that a 
connection is established between the two end-points and is 
maintained until the data has been successfully exchanged 
between the communicating applications. 

Telnet - Telnet is a simple method with which to access 
another network device, e.g. a computer. The HTTP protocol 
and the FTP protocols allow you to request specific files 

from remote computers, but do not allow you logon as a 
user of that computer. With Telnet, you log on as a regular 
user with whatever privileges you may have been granted 
for specific applications and data residing on that computer.

TVL (TV Lines) - A method of defining resolutions in 
analog video.

UDP (User Datagram Protocol) - UDP is a communications 
protocol that offers limited service for exchanging data in a 
network that uses the Internet Protocol (IP). UDP is an 
alternative to the Transmission Control Protocol (TCP). The 
advantage of UDP is that it is not required to deliver all data 
and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no 
point in re-transmitting old information that will not be 
displayed anyway.

Unicast - Communication between a single sender and a 
single receiver over a network. A new connection is 
established for each new user. 

UPnPTM - A set of computer network protocols that allows 
the automatic peer-to-peer detection of devices on the 
network. UPnP is promoted by the UPnP Forum.

URL (Uniform Resource Locator) - An "address" on the 
network.

USB - (Universal Serial Bus) A plug-and-play interface 
between a computer and peripheral devices, e.g. scanners, 
printers, etc.

Varifocal lens - A varifocal lens provides a wide range of 
focal lengths, as opposed to a lens with a fixed focal length, 
which only provides one. 

VPN (Virtual Private Network) - This creates a secure 
"tunnel" between the points within the VPN. Only devices 
with the correct "key" will be able to work within the VPN. 
The VPN network can be within a company LAN (Local Area 
Network), but different sites can also be connected over the 
Internet in a secure way. One common use for VPN is for 
connecting a remote computer to the corporate network, via 
e.g. a direct phone line or via the Internet.

VOP (Video Object Plane) - A VOP is an image frame in an 
MPEG-4 video stream. There are several types of VOP:

- An I-VOP is complete image frame.

- A P-VOP codes the differences between images, as long as 
it is more efficient to do so. Otherwise it codes the whole 
image, which may also be a completely new image. 

WAN (Wide-Area-Network) - Similar to a LAN, but on a 
larger geographical scale. 

W-LAN (Wireless LAN) - A wireless LAN is a wireless local 
area network that uses radio waves as its carrier: where the 
network connections for end-users are wireless. The main 
network structure usually uses cables.

Web server  - A Web server is a program, which allows 
Web browsers to retrieve files from computers connected to 
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the Internet. The Web server listens for requests from Web 
browsers and upon receiving a request for a file sends it 
back to the browser.

The primary function of a Web server is to serve pages to 
other remote computers; consequently, it needs to be 
installed on a computer that is permanently connected to 
the Internet. It also controls access to the server whilst 
monitoring and logging server access statistics.

WEP (Wireless Equivalent Privacy) - A wireless security 
protocol, specified in the IEEE 802.11 standard, which is 
designed to provide a wireless local area network (WLAN) 
with a level of security and privacy comparable to that 
usually expected of a wired LAN. Security is at two different 
levels; 40-bit and 128-bit encryption. The higher the bit 
number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the 
Microsoft Windows NT Server, WINS manages the 
association of workstation names and locations with IP 
addresses, without the user or administrator having to be 
involved in each configuration change. 

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) - 
This wireless encryption method uses a pre-shared key (PSK) 
for key management. Keys can usually be entered as manual 
hex values, as hexadecimal characters, or as a Passphrase. 
WPA-PSK provides a greater degree of security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to 
enlarge the view of an object to show more detail. 
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